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前  言 

概述 

本文档主要介绍 HiBurn 烧写工具的使用方法，适用于一键烧写所有程序镜像到单板

flash 上的场景、单板已有 boot 可按地址烧写其他程序镜像到单板 flash 上的场景，以

及在空板上只烧写 boot 到单板 flash 上的场景。 

产品版本 

与本文档相对应的产品版本如下。 

产品名称 产品版本 

Hi3516A V100 

Hi3516C V200 

Hi3516C V300 

Hi3516E V100 

Hi3518E V20X 

Hi3519 V100 

Hi3519 V101 

Hi3516A V200 

Hi3520D V100 

Hi3521 V100 

Hi3521A V100 

Hi3531 V100 

Hi3531A V100 

Hi3535 V100 

Hi3536 V100 

Hi3559 V100 
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产品名称 产品版本 

Hi3556 V100 

Hi3536C V100 

Hi3559A V100ES 

Hi3536D V100 

Hi3559A V100 

Hi3559C V100 

Hi3531D V100 

Hi3521D V100 

Hi3520D V400 

Hi3519A V100 

Hi3556A V100 

Hi3516C V500 

Hi3516D V300 

Hi3516A V300 

Hi3559 V200 

Hi3556 V200 

Hi3516E V200 

Hi3516E V300 

Hi3518E V300 

Hi3516D V200 

 

读者对象 

本文档（本指南）主要适用于以下工程师： 

 技术支持工程师 

 硬件开发工程师 

修订记录 

修订记录累积了每次文档更新的说明，最新版本的文档包含以前所有文档版本的更新

内容。 
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修订日期 版本  修订说明 

2019-6-20 11 新增 1.6 小节 

2019-04-15 10 增加 Hi3516DV200 

1.4 小节，表 1-1 涉及修改 

1.5 小节，步骤 7 涉及修改 

5.2 小节，步骤 4 涉及修改 

2019-03-29 09 新增第 7 章 

新增 9.20 小节 

2019-03-05 08 添加 Hi3516AV300 相关内容 

2018-12-20 07 刷新部分章节的图片，保持跟工具一致。 

1.4 小节，表 1-1 涉及修改 

2018-11-30 06 增加 Hi3518EV300、Hi3516EV200、Hi3516EV300 

1.4 小节，表 1-1 涉及修改 

2018-11-02 05 1.4 小节，表 1-1 涉及修改 

2018-08-30 04 2.2 小节步骤 2 涉及修改 

增加 Hi3516CV500 和 Hi3516DV300。 

2018-06-15 03 1.5 小节步骤 7 涉及修改 

2018-05-20 02 增加 Hi3519AV100 

2017-11-20 01 增加 Hi3559AV100 

2017-08-15 00B09 增加 Hi3536DV100 

2017-03-30 00B08 增加 Hi3536C 和 Hi3559 AV100ES。 

2017-02-25 00B07 更新 1.5 小节步骤 2 

2016-12-27 00B06 1.5 小节步骤 7 添加注意 

2016-10-29 00B05 1.5 小节步骤 7 涉及修改，新增 8.19 小节 

2016-09-28 00B04 新增 8.12、8.13 和 8.14 小节。 

2016-08-30 00B03 补充 1.5 小节中的步骤 7 

2016-07-26 00B02 第 2 次临时版本发布。 

2015-08-04 00B01 第 1 次临时版本发布。 
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1 概述 

1.1 工具概述 

HiBurn 工具主要是用于镜像烧写、镜像上载与烧片器镜像制作的多功能工具。 

1.2 应用场景 

HiBurn 工具三大主要功能的应用场景如下： 

 镜像烧写：应用于将镜像通过串口、网口或 USB 口烧写到对应 Flash 地址上； 

 镜像上载：应用于将 Flash 地址上数据通过 DDR 导出到 PC 上的文件中； 

 烧片器镜像制作：应用于将分区表中的镜像按照烧片器工具要求的格式打包成对

应的镜像文件以供烧片器量产烧写。 

1.3 烧写原理 

uboot 烧写原理：HiBurn 工具在开始烧写后，首选与 bootrom 进行交互，工具 DDR 参

数传送到传到 bootrom，即为 uboot 下载阶段 5%处，然后初始化 DDR，再把 uboot 传

输到 DDR 中，uboot 下载阶段 100%处表示传输完毕，再从 DDR 启动 uboot，uboot 启

动完成后，工具开始与 uboot 进行交互，发送烧写命令，将 DDR 中的 uboot 烧写到

Flash 对应地址中。 

其他镜像分区烧写原理：其他镜像分区，如 kernel，rootfs 等分区，工具默认采用网口

传输的方式，客户可选择裸烧和非裸烧两种方式进行烧写，裸烧即为在按分区烧写或

按 Emmc 烧写中勾选 uboot 进行烧写，此时 uboot 会被烧写到 Flash 中，非裸烧即为不

勾选 uboot，仅勾选其他分区进行烧写，此时需要保证当前单板上已经存在 uboot，烧

写时工具会启动 uboot，与其交互，通过向 uboot 发送 TFTP 命令与 Write 命令，完成

烧写。 
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1.4 工具与单板器件匹配关系说明 

对不同的单板，HiBurn 工具在功能与器件上的支持有所差异。具体支持情况如表 1-1

所示。 

表1-1 工具与单板器件匹配关系说明 

芯片型号 Flash 类型 文件系统 高级功能 通用接口 

Spi 
nor 

Spi 
Nand
/Nan
d 

eM

MC 

Uf

s 

Yaff

s 

Jffs

2 

SquashF

S 

UB

I 

ext3/

4 

C

A 

Bad 

Chec

k 

串 

口 

网 

口 

US

B 

Hi3518EV200 

Hi3518EV201 

Hi3516CV200 

Hi3519V100 

Hi3519V101 

Hi3536 

Hi3516AV200 

              

Hi3516DV300 

Hi3516AV300 

              

Hi3516A 

Hi3520D 

Hi3521 

Hi3521A 

Hi3531 

Hi3531A 

Hi3535 

Hi3536CV100 

Hi3536DV100 

Hi3531DV100 

Hi3521DV100 

Hi3520DV400 

              

Hi3559V100 

Hi3556V100 

              

Hi3516CV300 

Hi3519AV100 

Hi3516CV500 

              

Hi3556AV100               
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芯片型号 Flash 类型 文件系统 高级功能 通用接口 

Spi 
nor 

Spi 
Nand
/Nan
d 

eM

MC 

Uf

s 

Yaff

s 

Jffs

2 

SquashF

S 

UB

I 

ext3/

4 

C

A 

Bad 

Chec

k 

串 

口 

网 

口 

US

B 

Hi3559AV100

ES/Hi3559AV
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Hi3559V200/ 

Hi3556V200 

              

Hi3518EV300               

Hi3516EV200 

Hi3516EV300 

Hi3516DV200 

              

注：表示支持；表示不支持。 

 

1.5 环境准备 

HiBurn 工具烧写的环境准备如下： 

步骤 1 PC 与单板之间连接好串口、网线，且因工具烧写需要涉及到与 bootrom 交互，故单板

硬件上 bootrom_sel 需要设置为 1，从 bootrom 启动。 

步骤 2 把位于 SDK 发布包中的 HiTool-BVT-X.X.X.zip（路径：$SDK_DIR/ 

tools/windows/HiTool），拷贝到 PC 上（PC 要求安装 Win7、XP 操作系统）的某个本

地硬盘。 

在 HiTool-XXX-4.0.15 及以后的版本已经集成了 jre，无需单独安装 JRE。 

如果是老版本工具，请预先安装的 32 位的 jre1.6(如 jre-6u1-windows-i586-p)，否则

HiTool 可能无法运行。链接如下： 

http://www.oracle.com/technetwork/java/javase/downloads/java-archive-downloads-javase6-

419409.html 

查看当前 PC 安装的 JRE 版本号，可以通过在开始->运行->键入 cmd 中输入 java –

version 查看当前已安装的 JRE 版本号，若当前版本为 1.6.0_xx 即可，若当前版本号高

于 1.6，则请参考 FAQ 7.15。 

步骤 3 解压 HiTool-BVT-X.X.X.zip，双击工具目录下的 HiTool.exe，打开 HiTool 工具，如图

1-1 所示。 

http://www.oracle.com/technetwork/java/javase/downloads/java-archive-downloads-javase6-419409.html
http://www.oracle.com/technetwork/java/javase/downloads/java-archive-downloads-javase6-419409.html


 

HiBurn 

工具使用指南 1 概述 
 

文档版本 11 (2019-06-20) 版权所有 © 上海海思技术有限公司 4 

 

图1-1 从 HiTool 工具目录打开 HiTool 工具 

 

 

步骤 4 选择单板对应的芯片型号，以 Hi3518EV200 为例，如图 1-2 所示。 

图1-2 选择单板对应的芯片型号 

 

 

步骤 5 在欢迎页中选择 HiBurn 工具，如图 1-3 所示。 
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图1-3 选择 HiBurn 工具 

 

 

步骤 6 参数配置，选择连接单板所用的串口，选择 PC 端使用的网络 IP 地址，配置好单板的

MAC 地址、IP 地址、子网掩码以及网关，配置如图 1-4 所示。 

 

 

所选择的 PC 的服务器 IP 必须和单板的网络配置在同一个网段内，否则无法通过网口

烧写除 fastboot 以外的其他镜像（fastboot 镜像是通过串口烧写的）。 
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图1-4 参数设置 

 

 

步骤 7 可选步骤，Hi3516CV300/Hi3559AV100/Hi3556AV100/Hi3519AV100/Hi3516CV500 

Hi3516DV200/ 

Hi3516DV300/Hi3516AV300/Hi3559V200/Hi3556V200/Hi3516EV200/Hi3516EV300/Hi35

18EV300 芯片支持 USB 裸烧，
Hi3559V100/Hi3556V100/Hi3559AV100/Hi3556AV100/Hi3519AV100/Hi3516DV200/ 

Hi3516EV200/Hi3516EV300/Hi3518EV300 芯片支持 USB 非裸烧。 

 

 

 由于 USB 裸烧或非裸烧，还跟板端配置及软件配合相关，实际是否支持以实际发布

版本为准。 

 Hi3516CV300/Hi3516EV100，Hi3559AV100/Hi3559CV100，

HI3519AV100/Hi3556AV100，HI3516CV500/Hi3516DV300/Hi3519V200/Hi3556V200/ 

Hi3516AV300 等芯片不支持 win10 系统上使用 usb 方式烧写。 

使用 usb 烧写方式，需要提前在 Windows 平台的 PC 机上，安装好指定的驱动，在线

安装方法如下： 
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1. 从 http://zadig.akeo.ie 上下载 zadig.exe 文件，请根据自己的操作系统下载相应的

exe 执行文件，当前最新版本如下（请以实际为准）： 

 zadig_2.3.exe 

以 win7 系统下驱动安装为例。 

2. 用 HiBurn 工具串口功能烧写 uboot，烧写完成之后，在单板的 uboot 下输入命令

usb device，USB 接口与 PC 端相连，进入升级模式，PC 端设备管理器出现

HiUSBBurn 设备如图 1-5 所示。 

图1-5 设备管理器 

 

 

此时 windows 会自动搜索驱动程序，等待 windows 搜索驱动程序搜索不到之后。 

3. 打开 zadig_2.3.exe 文件，选择 Options->List All Devices，将 List All Devices 勾

上，如图 1-6 所示。 

图1-6 勾选 List All Devices 

 

 

4. 在红色方框位置选择 hiUSBBurn 设备，然后方框内选择驱动 libusbK，点击“Install 

Driver”，如图 1-7 所示。 

 

http://zadig.akeo.ie/


 

HiBurn 

工具使用指南 1 概述 
 

文档版本 11 (2019-06-20) 版权所有 © 上海海思技术有限公司 8 

 

 

单板上电时，需要进入 USB 模式，进入 USB 模式的方法请参考 SDK 包里面的文档

《Hi35xxVxxx SDK 安装使用说明》。 

图1-7 安装 libusbK 

 

 

5. 出现如下对话框，在点击安装如图 1-8 所示，liusbK 安装成功如图 1-9 所示。 

图1-8 安装 
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图1-9 安装成功 

 

 

6. LibusbK 安装完成之后，打开设备管理器，查看驱动是否安装正确，如图 1-10 为

正确安装后的状态。 
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图1-10 驱动正确安装后的设备管理器 

 

 

----结束 

1.6 USB 驱动的离线安装包制作 

1.5 章节“环境准备”中步骤 7 中的 USB 驱动安装步骤复杂，而且安装的时候必须要准

备一块已经烧写了 boot 的单板，本章节提供一种离线驱动安装包的制作方法，只需一

次性制作出来，后续每个使用此安装包的用户不需 PC 连接单板即可安装驱动。制作步

骤如下： 

步骤 1 准备一个烧写了 boot 的单板，在单板的 uboot 下输入命令“usb device”，单板进入升级

模式，单板通过 USB 与 PC 连接，这时可以在设备管理器出现名为 HiUSBBurn 的 usb

设备。 

步骤 2 下载 libusbK 开源软件。开源软件托管网址为：https://sourceforge.net/projects/libusbk/，

下载其安装程序如：libusbK-3.0.7.0-setup.exe 

步骤 3 运行安装程序，均使用默认选项安装。 

https://sourceforge.net/projects/libusbk/
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步骤 4 运行 Drvier Install Creator wizard。弹出如图 1-11 所示对话框。选中“libusbk”和

“libusb0”，然后点击“Next”。 

图1-11 Infwizard-USB Inf 

 

 

步骤 5 选择“Show All Device”，如果当前 PC 识别到了海思的单板的 HiUSBBurn，则列出该

设备详细描述。选中 HiUSBBurn，点击 Next，Next。  

步骤 6 如下图 1-12 选择“Client Install”，输入安装包生成的路径，安装包的名称，点击

next。 

图1-12 Infwizard-Install/Save Package 

 

 

步骤 7 点击 Finish，完成安装包的制作。可以看到生成了安装程序，如图 1-13 所示。该程序

可以在不插单板的 PC 上安装 usb 驱动。 
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图1-13 离线安装包详细内容 

 

 

----结束 
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2 按分区烧写 

2.1 适用场景 

按分区烧写功能，适用于所有的单板，不管单板上有没有 boot 都适用。 

2.2 烧写步骤 

具体烧写步骤如下： 

步骤 1 打开 HiBurn 后，切换到“Burn by Partition”页签，如图 2-1 所示。 
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图2-1 HiBurn 按分区烧写 

 

 

 
 软件第一次打开时，软件会自动生成默认参数，当这些参数配置信息更改时，软件会自动记

录更改后的最新值，在软件正常退出时，自动保存配置参数，下次启动时，使用最新配置参

数，如软件遇到非法退出，软件的配置参数可能不会被正确保存，即最近一次的参数修改失

效。 

 点击保存按钮，可以将当前板端的网络配置保存起来，点击加载按钮，可以从保存的结果中

选择一组配置作为当前配置。 

 切换“默认采用 XML 所在路径”的勾选状态，若勾选，则优先在 XML 路径下查找该分区文

件。若不勾选，则优先采用绝对路径查找该文件，若找不到，再尝试以在 XML 所在目录下

查找该文件。 

 XML 是一个配置文件用于保存分区表信息的，可以将编辑的分区表使用工具上的 Save 按钮

保存成一个 XML 文件，下次打开工具时，将 XML 导入进来，分区表信息就直接加载进

来。 

步骤 2 配置单板分区信息，点击浏览按钮 ，可选择已设置好的分区表信息的 XML，

载入到工具中，分区信息被加载，如图 2-2 所示。 
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图2-2 配置单板分区信息 

 

 

 

 分区信息只用于烧写，并不决定单板真正的分区划分，单板真实的分区划分还是由

单板的 bootargs 决定，请将此处的分区信息与单板 bootargs 指定的分区信息对应，

否则可能会出错。 

 HiBurn 支持分区路径不一致，支持远程烧写，即为烧写的镜像是远程路径下的镜

像。 

 分区被选中，但未选择烧写文件时，此分区在烧写过程中将会被擦除。 

 如果需要将所有分区的文件打包成一个镜像烧写（对于 nandflash，由于其本身特性

特殊，如果文件系统分区是可读写的文件系统，则不能一起打包），则打包的文件

必须要加载到 fastboot 分区进行烧写，并且镜像中需要包含 fastboot，才可以正常烧

写。因烧写 fastboot 分区是采用串口方式烧写，烧写速度较慢，故不推荐使用此种

方法进行烧写。 

修改分区信息可以直接修改 xml 格式的分区信息文件，也可以在工具中修改，用鼠标

点击需修改分区的所在列，即可修改，如图 2-3 所示。 

图2-3 编辑单板分区信息 

 

 

单击按钮 ，可以增加一行分区。可以在这一行修改分区名，选择 flash 类型以及

是否需要文件系统以及文件系统的类型，还可以修改分区的起始地址和分区大小。 
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 分区的起始地址和分区大小都是以 KB 或 MB 为单位，而且必须是 flash 块大小的整

数倍，否则可能会出错。 

 分区的文件系统中 jffs2 不是特殊格式，直接选择 none 即可 

 单击按钮 ，可选择或改变该分区的烧写文件。 

 单击按钮 ，可删除该分区信息。 

 

 

这里 fastboot 分区无法被删除，而且 fastboot 分区名不能被修改，因为如果 fastboot 分

区被删除或 fastboot 分区名被修改则无法实现一键烧写。 

 单击按钮 ，选择所有要烧写的分区，进行一键烧写所有分区，再次单击按钮

，则取消所有要烧写的分区，也可以点击复选框 ，选择相应的分区进行

烧写。 

 单击保存按钮 ，可以将编辑好的分区表保存为文件。 

说明  
单板分区信息在第一次打开工具时可能没有 xml 格式的分区信息文件，此时可以在工具界面中

直接填写或修改来创建单板分区信息，创建完成后，在关闭 HiTool 工具时，弹出如图 2-13 对话

框，会提醒是否保存分区信息，点击“确定”，在弹出的对话框中选择要保存分区信息的路径，

输入要保存的文件名，就会保存为 xml 格式的分区信息，点击“取消”，则关闭工具且不保存分

区信息。 

创建完成后在切换工具时，弹出如图 2-5 话框，“确定”，在弹出的对话框中选择要保存分区信息

的路径，输入要保存的文件名，就会保存为 xml 格式的分区信息，点击“取消”，则切换视图且

不保存分区信息。注意保存分区信息的文件名后缀必须为.xml 格式，否则下次载入分区信息时

可能会出错而无法正确载入分区信息。信息另存为如图 2-6 所示。 

图2-4 关闭 Hitool 工具时提醒是否保存分区信息界面 
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图2-5 切换视图时提醒是否保存分区信息界面 

 

 

图2-6 分区信息保存界面 

 

 

选中当前最后一行，点击新建 得到新的最后一行，然后在该行长度一栏中输入

“-”，再加入该行的分区名、文件系统以及文件的引用路径，在之后的烧写中即可计算

出该行的长度，该长度为整个器件的剩余长度。如图 2-7 所示。 



 

HiBurn 

工具使用指南 2 按分区烧写 

 

文档版本 11 (2019-06-20) 版权所有 © 上海海思技术有限公司 18 

 

图2-7 新建单板分区信息后设置长度为“-” 

 

 

 

若用户在新建分区行时，未选中当前的最后一个分区，则新建的分区可能不是新的最

后一个分区，则无法使用“-”来代表剩余长度。 

步骤 3 准备单板环境，选择一种传输方式，如图 2-8 所示，如果单板处于通电状态，给单板

下电。 

图2-8 选择传输方式 

 

 

 若选择网口，连接单板的串口和网口。 

 若选择串口，连接单板的串口。 

 若选择 USB，连接单板的 USB 口。 

 

 

不是所有芯片都支持 USB 传输方式。Hi3556AV100/Hi3559AV100 单板有两个 USB

口，只有 USB0 口才支持 USB device 升级。 
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步骤 4 烧写单板，点击烧写按钮 ，如图 2-9 所示。 

图2-9 点击烧写  

 

 

 

Hi3556AV100 单板点击烧写按钮后，需长按单板端的 update 按键，至少 50ms，复位单

板，松开 update 按键。 

步骤 5 给单板上电，进入烧写过程，等待烧写完成。烧写过程如图 2-10 所示。 

图2-10 烧写过程  

 

 

烧写过程的信息会在如上的控制台中显示。如果发现烧写出错，请再次检查单板： 

 串口选择是否正确。 

 IP 地址是否正确，是否被占用。 

 是否有短接单板上的自举跳线。 
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步骤 6 烧写完成，连接终端工具，重启单板。 

----结束 

2.3 制作 Nand 烧片器镜像 

HiBurn 提供了制作 Nand 烧片器镜像的功能。配置好分区列表后，点击制作 Nand 烧片

器镜像按钮 ，会弹出 Nand 烧片器镜像制作界面。如

图 2-11 所示。 

图2-11 制作 Nand 烧片器镜像界面 

 

 

选择对话框中的各项数据以后（其中 Randomization 功能对 8K 及以上 Page Size 的器件

开放），点击“Make”按钮，即可生成 Nand 烧片器的镜像。 
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 填入或选择的各项参数，必须与单板启动信息（可以使用超级终端类软件捕捉单板

的启动信息并查看）中对应项的数值一致或实际贴的器件参数匹配。 

 若用户不勾选某个分区，或者不为勾选的分区指定烧写文件，则无法制作该分区的

镜像文件。 

 若为非 yaffs 分区制作镜像，则分区表中的文件系统一项不能指定为 yaffs；为 yaffs

分区制作镜像时，文件系统必须指定为 yaffs。否则，会导致做出的镜像不正确。 

2.4 选中分区表单行点击跳转进入按地址烧写界面 

按分区烧写提供了携带子分区信息即分区的分区名、文件系统以及文件的引用路径和

起始地址以及分区长度跳转到按地址烧写界面，并采用该分区的信息直接录入到按地

址烧写信息栏中，方便用户使用。在按分区烧写界面中选中分区表中的一行，点击跳

转按钮 ，即可跳转到按地址烧写界面中。如图 2-12 与图 2-13 所示。 

图2-12 选中单行，点击跳转 

 

 

图2-13 进入按地址烧写界面  
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在跳转前，用户必须选中需要跳转到按地址烧写页面的分区行，跳转按钮才会显示。 
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3 按地址烧写 

3.1 适用场景 

单板已有 boot。 

3.2 烧写步骤 

具体烧写步骤如下： 

步骤 1 切换到“Burn by Address”页签，如图 3-1 所示。 

图3-1 地址烧写界面 

 

 

步骤 2 配置单板烧写信息，选择要烧写的 flash 类型，设置烧写起始地址和长度，选择要烧写

的文件，如图 3-2 所示界面。 
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图3-2 配置单板烧写信息 

 

 

步骤 3 同 2.2 步骤 3。 

步骤 4 单击烧写按钮 ，如图 3-3 所示。 

 

 

 按地址烧写时，用户无需选择文件类型，只要选择自己想要烧写的文件即可。由于

yaffs 文件（带 OOB 数据）和其他类型文件（不带 OOB 数据）的格式不同，工具

会根据选定的文件在后台自动区分文件类型（工具中区分为 yaffs 类型和 None 类

型），然后根据不同的类型来执行相应的烧写，给单板上电，进入烧写过程，等待

烧写完成，按地址烧写只有第一次点击烧写按钮时需要重新给单板上电，后续再烧

写镜像时不需要重新给单板上电了。 

 Hi3556AV100 单板点击烧写按钮后，需长按单板端的 update 按键，至少 50ms，复

位单板，松开 update 按键。 

图3-3 单击烧写 

 

 

步骤 5 给单板上电，进入烧写过程，等待烧写完成。烧写过程如图 3-4 所示。 
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图3-4 烧写过程 

 

 

烧写过程的信息会在如上的“控制台”中打印输出。如果发现烧写出错，请再次检查

单板： 

 串口选择是否正确 

 IP 地址设置是否正确，是否被占用 

 是否有短接单板上的自举跳线 

Erase 操作和 Burn 操作类似，这里不再赘述。 

步骤 6 烧写完成，连接终端工具，重启单板。 

——结束 

3.3 上载步骤 

烧写和上载是两个逆反操作，烧写功能是将镜像文件烧录到单板上，而上载功能则是

按照用户设置的起始地址和长度将这段区域的内容上载至 PC。上载的具体步骤完全可

以参考烧写步骤。这里列出两个和烧写步骤中不一样的地方，重复的地方不在累述。 

步骤 1 同 3.2 步骤 1。 

步骤 2 同 3.2 步骤 2。 
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步骤 3 配置单板上载信息，选择要上载的 flash 类型，设置存储设备中待上载的起始地址及长

度，并且设置上载后的保存文件。如图 3-5 所示。 

图3-5 上载信息 

 

 

步骤 4 同 3.2 步骤 3。 

步骤 5 单击“upload”，如果待上载区域的镜像是 fastboot，kernel，ubifs 等请选择 Data 

whithout OOB，如果镜像是 yaffs，请选择 Data with OOB。如图 3-6 所示。 

图3-6 选择数据类型 

 

 

 

按地址上载时，用户需要明确指定要上载的数据类型。这一步操作是在用户点击“上

载”按钮后的弹出对话框中完成的。如果用户在这一步选择错误，会导致上载后的数

据跟原始的文件无法吻合。yaffs 文件系统部分上载时，长度应该为 pagesize + oobsize

的倍数。 

----结束 

3.4 擦除步骤 

擦除功能是从指定地址开始将指定长度的内容从板端擦除。擦除的步骤同烧写步骤类

似，这里列出两个和烧写步骤中不一样的地方，重复的地方不在累述。 
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步骤 1 同 3.2 步骤 1。 

步骤 2 同 3.2 步骤 2。 

步骤 3 配置单板擦除信息，选择要擦除的 flash 类型，设置存储设备中待擦除的起始地址及长

度。如图 3-7 所示。 

图3-7 擦除信息 

 

 

步骤 4 同 3.2 步骤 3。 

步骤 5 单击“erase”，给单板上电，进入擦除过程，等待擦除完成。如图 3-8 所示。 

图3-8 擦除过程 
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擦除时，长度应该为 blocksize 的倍数。 

----结束 
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4 Boot 烧写 

4.1 适用场景 

单板上没有 boot，和按地址烧写配合，可完成单板所有镜像的烧写。 

4.2 烧写步骤 

具体烧写步骤如下： 

步骤 1 切换到“Burn Fastboot”页签，如图 4-1 所示。 

图4-1 Fastboot 烧写界面 
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步骤 2 配置串口，选择连接单板所用的串口，配置如图 4-2 所示。 

图4-2 串口选择 

 

 

步骤 3 配置 Boot 烧写信息，配置如图 4-3 所示。 

图4-3 配置 boot 烧写信息 

 

 

步骤 4 准备单板环境，如果单板处于通电状态，请给单板下电； 

步骤 5 点击烧写按钮 ，如图 4-4 所示。 



 

HiBurn 

工具使用指南 4 Boot 烧写 

 

文档版本 11 (2019-06-20) 版权所有 © 上海海思技术有限公司 31 

 

图4-4 点击 Burn 

 

 

步骤 6 给单板上电，进入烧写过程，等待烧写完成。烧写过程如图 4-5 所示。 

图4-5 烧写过程 

 

 

烧写过程的信息会在如上的“控制台”打印输出。如果发现烧写出错，请再次检查串口

选择是否正确。 

步骤 7 烧写完成，连接终端工具，重启单板。 

----结束 

 



 

HiBurn 

工具使用指南 5 eMMC 烧写 

 

文档版本 11 (2019-06-20) 版权所有 © 上海海思技术有限公司 32 

 

5 eMMC 烧写 

5.1 适用场景 

适用场景如下：只适用于 eMMC 烧写，不管单板上有没有 boot 都适用，可实现一键烧

写所有镜像。 

5.2 烧写步骤 

具体烧写步骤如下： 

步骤 1 切换到“烧写 eMMC”页签，如图 5-1 所示。 
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图5-1 eMMC 烧写界面 

 

 

 
 切换“默认采用 XML 所在路径”的勾选状态，若勾选，则优先在 XML 路径下查找该分区文

件。若不勾选，则优先采用绝对路径查找该文件，若找不到，再尝试以在 XML 所在目录下

查找该文件，该状态默认被勾选。 

 XML 是一个配置文件用于保存分区表信息的，可以将编辑的分区表使用工具上的 Save 按钮

保存成一个 XML 文件，下次打开工具时，将 XML 导入进来，分区表信息就直接加载进

来。 

步骤 2 配置单板分区信息，点击“浏览”，可选择已设置好的分区表信息，载入工具中，如

图 5-2 所示界面。 

图5-2 配置单板分区信息 

 

 



 

HiBurn 

工具使用指南 5 eMMC 烧写 

 

文档版本 11 (2019-06-20) 版权所有 © 上海海思技术有限公司 34 

 

 

如果所有分区的文件打包成一个镜像烧写时（由于 eMMC 文件系统分区需要创建分区

表，因此文件系统分区不同时，则不能一起打包，Android 版本不存在此问题），此镜

像必须要放到 fastboot 分区，而且此镜像中要包含 fastboot，另外由于此时是采用串口

方式烧写，烧写速度比较慢，要耐心等待。 

 

说明  
eMMC 采用 DOS 分区格式，对于 Ext3/4 文件系统分区需要创建分区表信息，内核才可以正确识

别 Ext3/4 文件系统分区。 

要修改某个分区的信息可以直接修改保存为 xml 格式的分区信息文件，也可以直接在

工具中修改，如果要在工具中修改某个分区的信息，用鼠标点击这个分区所在的行，

则会出现如图 5-3 所示。 

图5-3 编辑单板分区信息 

 

 

 

分区的起始大小和分区大小都是以 KB 或 MB 为单位，而且必须是 eMMC 扇区大小的

整数倍，否则可能会出错。 

 单击按钮 ，可以增加一行分区。可以在这一行修改分区名、选择是否需要

文件系统以及文件系统的类型，还可以修改分区的起始大小和分区大小。 

 单击按钮 ，可选择或改变该分区的烧写文件。 

 单击按钮 ，可删除改分区信息。注意：这里 fastboot 分区无法被删除，而且

fastboot 分区名不能被修改，因为如果 fastboot 分区被删除或 fastboot 分区名被修

改则无法实现一键烧写。 

 单击按钮 ，选择所有要烧写的分区，进行一键烧写所有分区，再次单击按钮

 ，则取消所有要烧写的分区，也可以点击复选框 ，选择相应的分区进行

烧写。 

 单击按钮 ，可以将编辑好的分区表保存为文件。 
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创建完成后在切换透视图时，弹出如图 2-5 话框，“确定”，在弹出的对话框中选择要保存分区信

息的路径，输入要保存的文件名，就会保存为 xml 格式的分区信息，点击“取消”，则切换视图

且不保存分区信息。注意保存分区信息的文件名后缀必须为.xml 格式，否则下次载入分区信息

时可能会出错而无法正确载入分区信息。信息另存为如图 2-6 所示。 

图5-4 关闭 Hitool 工具时提醒是否保存分区信息界面 

 

 

图5-5 切换视图时提醒是否保存分区信息界面 

 

 

信息另存为如图 5-6 所示。 
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图5-6 分区信息保存界面 

  

 

步骤 3 同 2.2 步骤 3。 

步骤 4 烧写单板，点击烧写按钮 ，如图 5-7 所示。 

图5-7 点击烧写 

 

 

 

Hi3556AV100/Hi3519AV100/Hi3559AV100/ 

Hi3516DV200/Hi3516EV200/Hi3516EV300/Hi3518EV300 单板点击烧写按钮后，需长按

单板端的 update 按键，至少 50ms，复位单板，松开 update 按键。 

步骤 5 给单板上电，进入烧写过程，等待烧写完成。 

烧写过程的信息会在控制台中显示。 

 串口选择是否正确。 

 IP 地址设置是否正确，地址是否被占用。 
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 是否有短接单板上的自举跳线。 

步骤 6 烧写完成，连接终端工具，重启单板。 

----结束 

5.3 制作烧片器镜像 

制作烧片器镜像功能可以将当前分区列表中选择的文件制作为烧片器镜像文件。配置

好分区列表后，点击制作烧片器镜像按钮 ，在弹出的保存

对话框中设置好文件路径，制作烧片器镜像就开始了，如图 5-8 所示。 

图5-8 制作烧片器镜像过程 

 

 

5.4 上载步骤 

emmc 烧写是将镜像文件烧录到 emmc 器件上，而 emmc 上载则是按照设置的起始地

址和长度将这段内容上载至 PC。上载的具体步骤完全可以参考烧写步骤。这里列出两

个和原来烧写步骤中不一样的地方，重复的地方不在累述。 

步骤 1 同 3.2 步骤 1。 
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步骤 2 同 3.2 步骤 2。 

配置上载信息，可以设置上载的起始地址在“起始栏”及长度在“长度栏”，点击“浏览”

栏，可以选择将这个上载的内容保存在 PC 上某个具体的文件中。 

步骤 3 同 3.2 步骤 3。 

步骤 4 准备上载，点击“上载”按钮，会将数据保存到指定的文件中，上载过程如图 5-9 所示。 

图5-9 上载过程 

 

 

----结束 
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6 合并镜像 

6.1 适用场景 

适用场景如下：适用于 SPI Flash 中因存储空间较小，用户需要将多个小镜像合并为一

个镜像，然后烧录到同一个 block 块中，从而节省 flash 空间的场景，也适用于将其他

Flash 类型的镜像合并为一个镜像。 

例如，有 fastboot，kernel 两个镜像他们分别为 500K，而 spi 的 block 大小为 1M，那么

如果将这两个镜像当做两个分区来烧写，板端烧写命令会使用到 2 个 block 块来占用，

如果合并镜像后，就只需要占用单个 block 块即可，从而省了 1M 的 Flash 空间。 

6.2 操作步骤 

具体烧写步骤如下： 

步骤 1 切换到“Merge Image”页签，如图 6-1 所示。 
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图6-1 HiBurn 合并镜像界面 

 

 

步骤 2 点击 Browse 按钮，加载分区表或点击 按钮，手动新建分区表，如图 6-2 所示。 

图6-2 加载分区表 

 

 

步骤 3 点击 Merging Image 按钮，合并镜像，如图 6-3 所示。 
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图6-3 合并镜像 

 

 

----结束 
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7 DDR 烧写 

7.1 适用场景 

适用场景如下：主要适用于没有网口的单板上进行 Huawei LiteOS 的开发调试用。 

在消费类 IPC 单板上很多都没有网口，Huawei LiteOS 镜像需要每次都重新下载镜像并

启动，如果使用 USB 裸烧是直接烧到 flash 中的，对于 spi nor flash，每秒烧写速度只

有 110KB/S 左右，要下载一个较大的程序，很耗时间。 

使用 USB 将镜像通过 HiTool 下载到单板的内存中，并直接启动，可以省掉烧写 Flash

的时间。 

7.2 操作步骤 

具体烧写步骤如下： 

步骤 1 切换到“DDR Burn”页签，传输方式选择 USB Port，如图 7-1 所示。 
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图7-1 HiBurn DDR Burn 界面 

 

 

步骤 2 选择烧写的镜像文件路径，如图 7-2 所示。 
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图7-2 镜像文件路径 

 

 

步骤 3 点击 Start Burn 按钮，如图 7-3 所示。 
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图7-3 Start Burn 

 

 

步骤 4 串口工具连接单板，通过串口输入命令 usbtftp 0x40000000 media_app_zip.bin，如图 7-

4 所示。 

图7-4 输入命令 

 

 

----结束 
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8 首选项设置 

8.1 TFTP 设置 

HiBurn 工具的 TFTP 可通过首选项进行设置，点击菜单栏中“窗口”->“首选项”进

入首选项对话框，进入“HiBurn”下的“TFTP 设置”页面，如图 8-1 所示。 

图8-1 TFTP 设置页面 

 

 

设置项： 
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 TFTP 速率：用于计算超时，根据传输文件的长度及设置的 TFTP 速率计算出超

时。单位为 byte/s。 

 处理丢包：勾选“处理丢包”按钮，连续丢包次数项可配置，在传输过程中若连

续丢失的包达到最大连续丢包次数，则判定传输失败。若不勾选“处理丢包”按

钮，连续丢包次数项不可配置，且不管传输过程中的丢包情况。 

 连续丢包次数：设置最大连续丢包次数。 

 TFTP 重试次数：设置 TFTP 重试次数，若传输失败，将重试，达到重试设置次数

后仍未成功，将停止。 

 TFTP 无响应超时：设置 TFTP 无响应超时，传输过程中若在设置时间内无响应，

则判定传输失败，单位为秒，默认值为 10 秒。 

8.2 其他设置 

8.2.1 HiBurn-Debug 控制台设置 

HiBurn 工具的 Debug 控制台可通过首选项进行设置。 

步骤 1 点击菜单栏中“窗口”->“首选项”进入首选项对话框，进入“HiBurn”页面，选中

“Open Debug Mode”按钮，表示开启 Debug 控制台，如图 8-2 所示。 
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图8-2 选中开启 Debug 控制台 

 

 

步骤 2 在开始烧写后，工具会自动创建 Debug 控制台，点击控制台右上角切换控制台按钮，

选择切换控制台为“HiBurn-Debug”控制台，当前控制台就显示为 Debug 控制台，如

图 8-3 所示。 

图8-3 切换 HiBurn-Debug 控制台 
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8.2.2 检查同一网段设置 

点击菜单栏中“窗口”->“首选项”进入首选项对话框，进入“HiBurn”页面，选中

“Check whether the PC and Borad IP addresses are in the same network segment”按钮，如

图 8-4 所示，表示开启在烧写前检查 PC 与板端 IP 是否在同一网关，取消选中则表示

不会在烧写前检查此项，  

图8-4 检查同一网段设置页面 
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9 FAQ 

9.1 HiBurn 烧写中出现 TFTP 超时提示时的解决办法 

问题描述 

出现以下 TFTP 错误时，如图 9-1 所示，该如何解决？ 

图9-1 TFTP 超时问题 

 

 

解决办法 

解决此问题分以下四个方面： 

 检查 HiBurn 中网络配置是否正确，如图 9-2 所示，首先检查服务器 IP 是否正确，

若不正确点击重新加载，加载最新的 PC 端 IP 地址；然后检查子网掩码与网关是

否配置正确，若正确，再检查板端 IP 地址是否被占用（使用 ping 命令，查看当前

单板 IP 是否能够 ping 通，若不能则表示当前网络不通），再查看，将以上参数全

部保证正确后再尝试重新烧写。 
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图9-2 检查网络配置是否正确 

 

 

 使用外置的 tftpd32 工具代替工具中内置的 TFTP 进行下载操作（如何使用外置

tftpd32 如 9.2 章节所示），若 tftpd32 也显示超时，则检查当前网络环境是否正

常； 

 修改工具中 TFTP 参数设置，匹配当前网络环境，通过点击菜单栏上的

“Window”->“Preferences”->“HiBurn”->“TFTP Setting”，如图 9-3 所示，将

“The number of consecutive packet loss”与“TFTP no response timeout”两个参数

设置大一些，然后在进行烧写，查看是否正常。 

 检查是否关闭防火墙，若未关闭，需要关闭防火墙。 
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图9-3 修改 TFTP 设置 

 

 

9.2 如何使用外置的 tftpd32 进行镜像下载？ 

问题描述 

如何使用外置的 tftpd32 进行镜像下载且需要注意什么？ 

解决办法 

使用外部 tftpd32 步骤为： 

步骤 1 在烧写前打开 tftpd32 工具，并选择正确的 PC 端 IP 地址与将烧写的镜像所在目录，如

图 9-4 所示。 
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图9-4  配置 tftpd32 工具 

 

 

步骤 2 在 HiBurn 中正常点击烧写按钮，弹出提示框，如图 9-5 所示，点击确认，开始烧写，

当前就会使用外置的 tftpd32 进行镜像的下载，如图 9-6 所示。 

图9-5 提示内置 TFTP 启动失败，端口被外置 tftpd32 工具占用 
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图9-6 外置 tftpd32 工具正在下载镜像 

 

 

----结束 

9.3 HiBurn 烧写 Fastboot 分区时，工具出现报错“Failed to 

send start frame”的解决办法 

问题描述 

烧写 Fastboot 分区出现以下“Failed to send start frame”错误时，如图 9-7 所示，我该

怎么办？ 

图9-7 “Failed to send start frame”报错信息 
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解决办法 

首先确认上一次点击烧写后，是否在 15 秒内给单板重新上电，若已经重新上电，则查

看串口是否与单板接触良好，若连接正常，则检查 HiBurn 中是否选择了正确的串口

号，如图 9-8 所示，全部保证正确后，请重新进行烧写。 

图9-8 检查串口号是否选择正确 

 

 

9.4 HiBurn 烧写 Fastboot 分区时，控制台只打印了一段

“#########”后停止打印，且工具出现报错“Failed to 

send head frame”的解决办法 

问题描述 

烧写 Fastboot 分区控制台只打印了一段“#########”后停止打印，且工具出现报错

“Failed to send head frame”时，如图 9-9 所示，该如何解决？ 

图9-9 “Failed to send head frame”报错信息 

 

 

解决办法 

此报错原因可能有以下两种： 

 烧写的 Fastboot 镜像与当前单板型号不匹配导致，请直接查看单板标记型号，明

确单板型号后，请使用匹配当前芯片的 SDK 镜像重新进行烧写； 

 单板 DDR 有问题，无法正常进行 DDR 初始化操作。 
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9.5 HiBurn 烧写 Fastboot 分区时，工具出现报错“Failed to 

send data frame”的解决办法 

问题描述 

烧写 Fastboot 分区出现以下“Failed to send data frame”错误时，如图 9-10 所示，我该

怎么办？ 

图9-10 “Failed to send data frame”报错信息 

 

 

解决办法 

此报错原因可能是烧写 Fastboot 镜像时串口连接出现松动导致工具与单板进行交互时

数据发送失败，请检查串口连接情况。 

9.6 HiBurn 烧写 Fastboot 分区时，工具出现报错“Failed to 

execute command”的解决办法 

问题描述 

烧写 Fastboot 分区出现以下“Failed to execute command”错误时，如图 9-11 所示，我

该怎么办？ 

图9-11 “Failed to execute command”报错信息 
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解决办法 

此报错原因可能是当前 Fastboot 分区的 Flash 类型选择错误导致的，如图 9-12 所示，

重启单板查看单板当前“Flash”属性，如当前为 eMMC，则需要使用按 EMMC 烧

写，且 Fastboot 分区的 Flash 类型选择为 emmc。 

图9-12 通过串口查看单板 Flash 信息 

 

 

9.7 对于文件传输方式的选择，需要注意什么？ 

问题描述 

在选择文件传输方式时，串口和网口之间的优缺点是什么？ 

解决办法 

HiBurn 工具的串口烧写功能是纯串口烧写，因烧写过程需给板端传送大量数据。而串

口本身的传输速率较低，故用纯串口的方式烧写，效率会比较低，我们推荐用网口的

方式进行烧写，纯串口的方式烧写非常稳定，若用户网络环境不稳定，可使用串口烧

写。 
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9.8 按地址烧写界面，文件的长度要求？ 

问题描述 

按地址烧写界面，文件的长度要求是什么？ 

解决办法 

擦除时，长度应该为 blocksize 的倍数；yaffs 文件系统部分上载时，长度应该为

pagesize + oobsize 的倍数。 

9.9 遇到点击烧写，断电重启后，不开始烧写，可能原因？ 

问题描述 

在点击烧写，断电重启后，但是工具并没有开始烧写，是什么原因？ 

解决办法 

可能是串口选择错误或没有正常连接串口（请使用终端工具查看），请等待，控制台会

打印出相关信息。 

9.10 串口找不到或 tftp 启动失败或报 tftp 端口被占用的原

因？ 

问题描述 

在 linux 下使用时，串口找不到或 tftp 启动失败或报 tftp 端口被占用，可能的原因什

么？ 

解决办法 

没有以 root 用户登录，无权限打开 tftp 服务或使用串口。报 tftp 端口被占用也有可能

是其他软件占用了此端口。 

9.11 烧写 Nand 时控制台打印 pure data length 和

len_incl_bad 分别是什么含义？ 

问题描述 

烧写 Nand 时控制台打印 pure data length 和 len_incl_bad 分别是什么含义？ 
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解决办法 

如图 9-13 所示，其中 pure data length 表示实际烧写的数据长度，而 len incl bad 表示包

含坏块的实际烧写占用的长度，以上两种长度均不包含 oobSize 长度。 

图9-13 控制台打印烧写命令反馈的烧写长度 

 

 

9.12 烧写 eMMC 时，若出现“Time out while receiving 

command execute result!”报错，该怎么办？ 

问题描述 

烧写 eMMC 时，若出现“Time out while receiving command execute result!”报错，该怎

么办？ 

解决办法 

此报错原因可能是：mmc write 命令执行后，等待命令执行后单板的反馈超时导致的，

需要通过点击菜单栏上的“Window”->“Preferences”->“HiBurn”->“Command 

Setting”，如图 9-14 所示，将命令的执行速率修改低一些，然后再重新进行烧写。 
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图9-14 在首选项中修改 mmc write 命令的速率 

 

 

9.13 eMMC 烧片器制作时，需要注意什么？ 

问题描述 

在 eMMC 烧片器制作时，需要注意什么？ 

解决办法 

 在制作 eMMC 烧片器镜像时若分区表中最后一个分区的长度为“-”，则需要用户

输入当前单板整个器件可用长度，用于计算最后一个分区的长度，如图 9-15 所示 
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图9-15 计算最后一个分区的长度 

 

 

 在制作 eMMC 烧片器镜像时，若分区中文件系统为 ext3/4，则可能会是稀疏镜像

若为当前分区为稀疏镜像，则会在控制台打印提示，如图 9-16 所示，若该稀疏镜

像解析数后的大小超过了整个分区的大小，则可能导致制作出来的烧片器镜像错

误，故若出现此种现象，则工具会在控制台打印提示，如图 9-17 所示 

图9-16 控制台打印当前分区为稀疏镜像 

 

 

图9-17 控制台打印当前分区的稀疏镜像解析数后长度超过了分区长度 
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9.14 eMMC 烧片器制作时，如何修改无效数据的填充值为

0x00 或 0xFF？ 

问题描述 

eMMC 烧片器制作时，如何修改无效数据的填充值为 0x00 或 0xFF？ 

解决办法 

需要通过点击菜单栏上的“Window”->“Preferences”->“HiBurn”->“Invalid Data 

Setting”，如图 9-18 所示，可以选择无效数据填充值为 0x00 或 0xFF，选择后，再制造

eMMC 烧片器镜像，就可以将无效数据填充为指定值。 

图9-18 在首选项中修改无效数据填充值 

 



 

HiBurn 

工具使用指南 9 FAQ 

 

文档版本 11 (2019-06-20) 版权所有 © 上海海思技术有限公司 63 

 

 

9.15 单板 DDR Training 失败的情况下工具会有什么打印？ 

问题描述 

单板 DDR Training 失败的情况下工具会有什么打印？ 

解决办法 

当单板出现 DDR Training 失败时，在烧写 Fastboot 分区时，会打印如图 9-19 所示信

息。 

图9-19 打印 DDR Training 失败信息 

 

 

9.16 反馈 HiBurn 使用过程中出现问题时需要提供什么？ 

问题描述 

反馈 HiBurn 使用过程中出现问题时需要提供什么？ 

解决办法 

使用 HiBurn 工具出现问题时，将控制台中打印内容通过控制台工具栏中导出按钮导

出，反馈问题时一并反馈，将有助于问题的定位及解决。 
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9.17 如何查看是否有进程占用了 tftp 的 69 端口？ 

问题描述 

tftp 命令总是报文件找不到，但实际所有的设置都是好的，原因是什么？如何查看是

否有进程占用了 tftp 的 69 端口？ 

解决办法 

可能存在后台进程占用了 69 端口。可以使用如下方法查看是否有进程占用。 

在 cmd 命令行工具中输入，打印例如图 9-20 所示： 

netstat -ano -p udp 

图9-20 查看进程的端口占用 

 

 

查看是否有进程占用了 69 端口，上图中可以看到 pid 为 7696 的进程占用了 69 端口。

再使用如下命令查看 7696 进程的名称，打印例如图 9-21 所示： 

tasklist|findstr "7696" 

图9-21 查看指定 PID 的进程名称 

 

 

然后在进程管理器中杀掉该进程即可。 

9.18 如果 PC 安装了 1.7 及以上版本 JRE？ 

问题描述 

PC 安装了 1.7 及以上版本 JRE，打开 HiTool 时报错如图 9-22 所示，该怎么办？ 
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图9-22 打开 HiTool 报错无法启动 JVM 

 

 

解决办法 

因 HiTool-XXX-3.1.20 以前的版本需要依赖 JRE1.6 版本，在 HiTool 启动时，需要加载

JRE1.6，否则会出现“Failed to create the Java Virtual Machine”报错，HiTool-XXX-

3.1.20 以后的版本可以直接支持 1.7 及更高版本的 JRE 

解决办法：打开 HiTool 目录下的 HiTool.ini，将其中-XX:MaxTenuringThreshold=31 参

数值改为-XX:MaxTenuringThreshold=15，即可支持 1.7 及更高版本的 JRE。 

9.19 如果是 64 位的 PC 且只安装了 64 位版本的 JRE？ 

问题描述 

PC 安装了 64 位版本的 JRE，打开 HiTool 时报错，该怎么办？ 

解决办法 

因 HiTool 依赖 32 位 JRE 版本，故在使用 HiTool 前，请先登录 JRE 官网，下载并安装

对应 JRE 版本的 Windows x86 的版本，网址如下：
http://www.oracle.com/technetwork/java/javase/downloads/ 

另，HiTool-XXX-4.0.15 以后的版本已经内置 JRE 程序，无需再次安装 JRE。 

9.20 非中文语言系统无法烧写中文路径镜像 

问题描述 

如果系统为非中文系统，工具传入中文路径系统是无法进行烧写的，查看语言系统的

方法，在 cmd 下输入 chcp 命令即可查询，如图 9-23，437 表示为美国语言系统，如果

是 936，则表示中文语言系统。 

http://www.oracle.com/technetwork/java/javase/downloads/
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图9-23 查询 windows 语言系统方法 

 

 

解决办法 

非中文语言系统不支持带中文路径的镜像，将烧写路径修改英文路径。 
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A 缩略语 

A  

AXI Advanced eXtensible Interface 

  

D  

DDR Double Data Rate 

  

E  

eMMC Embedded MultiMediaCard 

  

G  

GPIO General Purpose Input Output  

  

H  

HDMI High Definition Multimedia Interface 

  

N  

NAND NAND 

  

P  

PID Process Identification 
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